
        7085-UE2

                           UHF

       DATA TRANSCEIVERS

     

  PLL SYNTHESIZED (EEPROM)

            Service Manual

         

        

         
         

            

               HERMES ELECTRONICS CO., LTD.

HEC



               TABLE OF CONTENS

1. SPECIFICATION … … … … … … … … … … … … … … … … … … … … … … … … … . .2

2. CONNECTIONS  AND  OPERATION …… … … … … … … … … … … … … … … 3

3. CIRCUIT  DESCRIPTION … … … … … … … … … … … … … … … … … … … … ..4-12

4. PERFORMANCE  TEST  AND  ALIGNMENT … … … … … … … … … … … 12

5. TEST  EQUIPMENT CONFIGURATION   … … … … … … … … … … … … … 13

  

6. TRANSMITTER PERFORMANCE TEST … … … … … . … … … … … … … … … .14-16

7. TROUBLESHOOTING … … … … … … … … … … … … … … … … … … … … … … ..17-19

9. PARTS  LIST … … … … … … … … … … … … … … … … … … … … … … … … … … ..20-28

8. PROGRAMMER  INSTRUCTION … … .. … … … … … … … … … … … … … … … .29-34

10. PRINT CIRCUIT BOARD LAYOUT … … … … … … … … … … … … … … … … … 35

  

11. PARTS  ASSEMBLY … … … . … … … … … … … … … … … … … … … … … … … … .36

12. BLOCK DIAGRAM  … … . … … … … … … … … … … … … … … … … … … … … … 37

13. SCHEMATICS  DIAGRAM … … … … … … … … … … … … … … … … … … … … … 38

                                                                          PAGE1



1. SPECIFICATION

GENERAL  SPECIFICATIONS

POWER  SOURCE  … … … … … … … … … … … … … … … +12VD.C. nominal(+10.8 to +15.6V )

TEMPERATURE  RANGE

         STORAGE … … … … … … … … … … … … … … … .80℃ maximum  -40℃ min.

                                                 25℃ nominal

         OPERATING … … … … … … … … … … … … … … .70℃ maximum  -20℃ min.

ANTENNA  IMPEDANCE … … … … … … … … … … … … ...50Ω

FREQUENCY  CONTROL … … … … … … … … … … … … … ...PLL  SYNTHESISER

FREQUENCIES  OF  OPERATION … … … … … … … … … ..450-470MHZ

FREQUENCY  TOLERANCE  AND STABILITY … … … … ±1.5PPM

HIGH  HUMIDITY … … … … … … … … … … … … … … … … .90﹪

CHANNEL  CAPABILITY … … … … … … … … … … … … … . 1

NOMINAL  DIMENSIONS … … … … … … … … … … … … … .134 ㎜(L)X60㎜(W)X20㎜(H)

WEIGHT … … … … … … … … … … … … … … … … … … … … … .136g

RADIO DATA TRANSCEIVER NOMINAL PERFORMANCE

PERFORMANCE SPECIFICATIONS … … … … … … … … … ...ECC

RF  OUTPUT  POWER … … … … … … … … … … … … … … ..2W~3W

MODULATION  TYPE … … … … … … … … … … … … … … … .FM

INTERMEDIATE  FREQUENICES … … … … … … … … … … .21.4 MHZ

                                                   455 KHZ

CHANNEL  SPACING … … … … … … … … … … … … … … … .12.5KHZ

TRANSMIT  ATTACK  TIME … … … … … … … … … …＜25 mS

CURRENT  CONSUMPTION

            TRANSMIT … … … … … … … … … … … … .700mA@3W

            RECEIVE  … … … … … … … … … … … … ..85mA
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EXTERNAL  CONNECTIONS

1- 50Ω BNC SOCKET

2- 9 WAY 〝 D 〞TYPE  PLUG(J501)

2. CONNECTIONS  AND  OPERATION

D-TYPE  INTERCONNECTIONS

PIN FUNCTION  TYPE  RANGE DESCRIPTION
J501-1 DATA_IN ANALOGUE 106mV EXTERNAL MODULATION INPUT
J501-2 DATA_OUT ANALOGUE 250~350mV RECEIVER AF  OUTPUT
J501-3 PTT INPUT 0V/+5V TRANSMIT  ENABLE
J501-4 GND GND 0V GND
J501-5 B+ V+ +13.8V POWER  SUPPLY
J501-6 CDS OUTPUT OPEN/SHORT RF CARRIER  DETECT
J501-7 NC
J501-8 PGM_DATA INPUT 0V/NC PROGRAMMER DATA  INPUT
J501-9 PGM_ENB INPUT 0V/5V PROGRAMMING  ENABLE
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3. CIRCUIT  DESCRIPTION

TRANSMITTER

      The transmitter is comprised of:

       

     •   Audio amplifier connections from J1 pin 1

      •   Frequency Synthesizer

•   Transmitter

•   Automatic Power Control

Audio frequency connections

      Processed data from the IC201 is applied to the VCO via R316

   

Frequency synthesizer circuit

     With data received from the EEPROM (IC5) the frequency synthesizer circuit controls and

        Produces the RF carrier frequency for the transmitter during transmit and the local oscillator

        frequency for the receiver. The frequency synthesizer circuit is comprised of:

      •   12.8 MHZ Tcxo

      •   Voltage Controlled Oscillator (VCO) module

      •   Charge Pump and Loop Filter

      •   PLL Frequency Synthesizer

      •   Dual Modulus Prescaler
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PLL Synthesizer

       The PLL synthesizer circuit is common to both the transmitter and receiver,

       The synthesizer comprises:

                                                                                    

                                                    

                                                     

                                                    

                                                      

                                                          

                                                                        

       Data

                                                                            

                                                                           

                                                                           

                                                                           

                                                                             

                                                                           

                                                                          

                                                                            

                             RF  Out

                                               

12.8 MHZ TCXO

X1 is VCTCXO, which provide stable oscillator of 12.8 MHZ to PLL IC.

Frequency adjustment is provided by VR1.

.Voltage controlled oscillator module(VCO)

           The module produces carrier frequencies during transmit and local oscillator frequencies

           During receive.

           The module contains one VCO and three outputs. One for producing carrier frequencies during

           Transmit and one for producing the local oscillator frequency during receive and the other

           Output is for PLL IC(IC1) Fin.
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           The module also has Rx and TX powerline filters.

           RX and TX power line filters

           Transistor Q301 is configured as a 5v power supply ripple filter. The filter reduces the

           noise on the carrier and local oscillator signals.

  

           VCO

           The VCO comprises Q302, Coil L304, and varactor D301 D304 and is configured

           as a Colpits oscillator. D301 D304 produces a change in frequency with a change in DC voltage

           and is controlled by the tuning voltage signal present at the cathode. The local oscillator

           programmable dividers. DATA is received by IC1 at pin 10 from pin 11of IC3.

           

           The RF signal at the collector of Q302 is applied to an amplifier/buffer Q305.The amplified

           Signal from Q305 passes to the prescaler ,IC1 pin8 .The RF signal at the collector of Q302 also

           Drives the cascode amplifier/buffer formed by Q304 .

           When D201 is forward biased (TX ON) , carrier frequencies at the collector of Q304 pass to the

           Power amplifier and harmonic filter. When D303 is forward biased (RX) , local oscillator

           Frequencies at the collector of Q304 pass to the first mixer . VC1 adjusts the tuning

           Voltage of the VCO to the correct operating point.

            

           PLL IC

           The reference frequency from the TCXO, at 12.8 MHZ , is connected to pin 1 of IC1(MB1504)

             

           REFDIV divides the 12.8 MHz to produce a reference frequency (Fr) of 5 or 6. 25 kHz

           dependent upon channel spacing selected. VARDIV divides the prescaled VCO frequency

           to produce a variable frequency (Fv). Fv and Fr are fed to the phase detector.

           Phase detector

           When Fv=Fr, the phase detector output (pins 15 and 16,IC1) produces narrow negative pulses

           And Fv and Fr pulse widths are identical. When Fv〉Fr pin 15 (V) pulses negative with pin 16

           (R) remaining high. When Fv〈Fr pin 16 (R) pulses negative with pin 15(V) remaining high.

           The signal at pin 15 and 16 is smoothed the loop filter and applied to the VCO.

           Out-of-lock detector

           The out-of-lock detector produces a series of logic level pulses when the loop is out of lock at

           pin 7 of IC1.The pulses at pin 7 of IC1 are buffered by Q6 and then integrated by R17 and

           C19. The product of the integrating circuit is fed to Base of Q201.
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           Charge Pump and Loop Filter

           Transistors Q2,Q4,Q10 , and associated resistors and capacitors form the charge pump and loop

           Filter . The phase detector output from IC1 pins 15 and 16 are combined by the charge pump to

           Produce a 0 to 8V tuning voltage signal.

           The signal is filtered by the loop filter (R13,C15 and C20) to remove any residual reference

           Frequency harmonics from the signal.. After filtering the signal is applied to the voltage controlled

           Oscillator module.

           DC REGULATOR

           The DC Regulator IC2, converts the +13.6 V to a 8V supply . This is used to provide the

           Tuning voltage for the VCO . A wide voltage range is required to allow for the wideband operation

           Of the radio .

            

             

Dual modulus prescaler

       The prescaler divides the VCO frequency by 64 or 65.

Transmitter

 The transmitter comprises:

                     

      VCO Buffer          PA Module

           Amp
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 RF LPF
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  Automatic

 Power Control



 Buffer

   When the radio is in transmit mode the diode D201 is forward biases enabling the

modulated RF signal from the VCO to pass to the buffer/pre-amplifier Q204 and

associated components.

                                                                          

   The output signal is passed from Q204 to Q205 via a matching network consisting of

Inductor L201 and C208.

PA module

   The signal is then amplified for transmission by Q207, which is a power amplifier module.

Low pass filter

   The amplified RF signal is passed through the stripline coupler and is fed to the

harmonic low pass filter, comprising L213 to L214 and C232-C234 and then to the antenna

connector (ANT).

Antenna Switch

   When transmitting, the diodes D205 are forward biased, the RF pass to the antenna.

   D205 is shorted to ground which makes L212 look open circuit (1/4 wave

tuned stub). This prevents the TX signal from passing to the receiver stage.
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Receiver
   The receiver comprises:

                                                   

                                                  

                                                   

                                                  

                                                    

                                                      

                                                

                  SAW FILTER&

                      Amp

                                                                      

                                                                     

                                                                   

                                                                     

             IF Amp

                                                                     

                                                                      

                                                                       

                                                                     

                                                                         

                                                                      

                                                                       

                                                                     

                                                                     

                                                                    

 Data Out
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   Rx
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Antenna Switch

   In receive, the diode D205 are reverse biased. L212 is now in circuit, passing

   the signal from the antenna to the SAW filter of F101.

SAW FILTER

   The receiver signal is routed to pin 4 of the F101. It passes through the

   band pass filter .

     

   The input signal is coupled to the base of Q101 which serves as an RF amplifier.

   The output of Q101 is then coupled to the first mixer.

     

     

First Mixer

   Q102, 2-pole crystal filters XF1 and coils L103 and C120 form the First Mixer

   and First IF Filter.

    

  The RF signal, from the SAW filter and amplifier Q101 is

   applied to the VCO local oscillator signal to make mixer.

   The difference frequency of 21.4 MHz is taken from Q102 and is filtered by the crystal

   filters XF1. The tuned circuits L103 and C120 and associated components provide

   matching of the crystal filters to ensure a good pass-band response and selectivity.

   The IF signal is amplified by Q104 and passed to the FM Detector IC.

Second mixer, Second IF, FM detector

   The output of the IF amplifier is fed into the narrowband FM IF Integrated Circuit,

   IC101 (MC3361). This is a single conversion FM receiver which contains the second

   mixer, second IF amplifier, and FM detector.
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   Crystal X101,connected to pin 1 of IC101, determines the second local oscillator frequency.

   In this case the crystal has a frequency of 20.945MHz. The first IF signal is applied to

   the mixer and resultant frequency of 455KHz, is the difference between the IF signal

   and second local oscillator.

   The 455KHz IF signal is output from pin 3 and is applied to a 455KHz band-pass filter CF1.

  

     

   The output of CF1is passed via pin 5 to a high gain IF amplifier coupled to the

   adjustable quadrature detector T2.Any detected signal is produced at pin 9 of

   IC101 and applied to the Receiver Audio Circuit and the Mute (Squelch) Circuit.

Squelch ( MUTE ) Circuit

  

   Any noise signal is amplified by IC101 internal noise amplifier .

Signal is applied to pin10 of IC101. The squelch trigger output (pin 12,IC101) is applied to the

 pin 6 of J1.

     

    When noise is present, the voltage at pin 12 of IC101 is exceeds than 0.7V. The squelch trigger

output is open, It’s make pin 6 of J1 open state.

When no noise is present, the voltage at pin 12 of IC101 less 0.7v and pin 13 of IC101

 Is HI voltage. This make pin 6 of J1 short state.

  

VR101 is set to tuning squelch when 25khz channel space is present.

Carrier Detect

   A Carrier Detect ( MUTE DETECT ) output is available on pin 6 of J1 .

AF Output Low Pass Filter

   A low pass filter formed by R108 and C110 removes any extraneous 455kHz energy

   from the AF output of the FM receiver chip (pin 9 of IC101).

   The filtered signal is passed to pin 2 of J1.

  

Microcontroller

   The PIC16C57C04 microcontroller IC controls the programmable features and frequency synthesizer

   Data.
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Programming Mode

   The programming mode allows the user to retrieve or program TX/RX frequencies,

   when pin 9 of J1 is set to ground. Programming mode will Inhibit ,

   Serial communications can then be made in order to read/program the on- board

   EEPROM ( IC5 )which contains radio- specific data.

EEPROM

   Relevant channel information, such as Rx/ Tx frequencies, is stored in the EEPROM( IC5)

   which is a 93C46. This information may be programmed and erased via the D- type socket.

   The EEPROM has 1024 (8x128) capacity and is written serially.

Power supply circuit

   The data radio is supplied with a nominal + 13.8V dc power supply input from external

   equipment which is filtered using C33. This supply is converted into 8V

   voltage levels on the board using the regulator IC2 and associated components .

 

  

    The +5V VCC is regulated by Zener diode D1 and filtered using C9 and Q9. This +5V

    line is fed to the CPU circuit  .

4. PERFORMANCE TEST AND ALIGNMENT

    The alignment and performance test procedures assume the use of the following equipment.

              

 Discrete test equipment

    Volt Meter                            Spectrum Analyser and notch filter(option)

    RF Power Meter.                       Coupler (20dB isolation)

    DC Power Supply, 0-15V 2A min          Distortion  Meter

    Oscilloscope, 20 MHz dual beam

    RF Frequency Counter,

    100 kHz - 600 MHz

    AF Signal Generator 0 – 20 kHz

    RF Signal Generator

    SINAD Meter

    Modulation Meter

Audio Power Meter
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5. TEST EQUIPMENT CONFIGURATION.

                                                            

  RF Signal Generator

                                                  Watt Meter with

                                                  20dB Attenuator

                                                                  

                                                                   

                                                                  

  Audio Generator

                                             Modulation Meter

                                                                  

                                                               

                                                                     

                                                                

  SINAD  Meter                             OSCILLOSCOPE

                           RADIO

                                                                         

                                                                         

                                                                       

                                                                      

  VOLT Meter

                                            Spectrum Analyzer

                                                                       

                                                                     

                                                                      

                                                                     

                                                                       

 DC Power Supply

                                            Frequency Counter

                                                                       

                                                                        

                           Test Box

                                                                                

                                                                     

                                                                      

                                                                         

             Test Equipment Configuration
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6. TRANSMITTER PERFORMANCE TESTS

Power Output

   1.  Set the power supply voltage to 13.8V dc. and monitor the voltage during transmit.

   2.  Switch data radio TX and check and record the output power. The nominal output

       power is adjustable between 2 to 3W .

   3.  Set the PTT switch to OFF .

Peak Deviation

 1.  Connect the oscilloscope to the output of the modulation meter.

2. Set the AF signal generator to 1000 Hz at 106mV and connect to DATA _IN

    Line ( pin 1 of J1 )

3. Switch data radio to TX and observe the oscilloscope display to check that the 1000Hz

    tone is a sine wave and adjust VR201 to make deviation is about 3.5KHZ.

4. Using the AF signal generator, sweep from 100 Hz to 3 kHz and record the peak

deviation.

   5.  Check the peak deviation for appropriate channel spacing as follows：

       For 12.5 kHz channel spacing, Peak deviation is not greater than 2.5 kHz.

       For 20 kHz channel spacing, Peak deviation is not greater than 4 kHz.

       For 25 kHz channel spacing, Peak deviation is not greater than 5 kHz.

Spectrum Test

   It may be necessary to notch the fundamental signal during this test.

   1.  Connect a spectrum analyser and RF power meter to the antenna socket.

   2.  Switch data radio to TX. Observe the output spectrum on the spectrum analyser.

   3.  Adjust notch filter to minimise the carrier. All spurious and harmonics signals

       should be below- 36 dBm up to 1 GHz and below –30 dBm between 1 and 4 GHz.

4.  Switch off the data radio transmit control.

Receiver Performance Tests

  Sensitivity

   The SINAD performance test may be used to test the sensitivity of the receiver.

   1.  Connect the RF signal generator to the data radio BNC antenna connector.

   2.  Set the RF signal generator to the receive frequency .

   3.  Connect the leads of the SINAD meter between 0 V and pin 2 on J1.

   4.  Set the deviation to 60﹪of the peak system deviation.

   5.  Set the AF generator to 1 kHz.

   6.  Adjust the RF signal generator level until the SINAD Meter reads 12 dB.

7. Check that the signal generator RF level is less than 0.35uV pd (-116dBm ).
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Transmitter Alignment

Automatic Power Adjustment

  Transmit periods longer than 3 minutes are to be avoided.

   1.  Switch to data radio to TX.

   2.  make the transmit power between 2 to 3W.

   3.  Switch the data radio to transmitter OFF.

Frequency accuracy

   1.  Whilst transmitting, measure the transmit frequency using the RF frequency counter.

   2.  Adjust  VR1 so that frequency is as close as possible to the exact required transmit

 frequency. Ideally it should be within 100 Hz at room temperature.

Receiver Alignment

     Important note：Before setting up the receiver it is important to check the frequency

     accuracy alignment is correct as described in the transmitter alignment section.

RF tuning

    1.  Connect an RF signal generator and SINAD voltmeter.

    2.  Set the RF signal generator to the receive channel frequency and set to 60﹪deviation.

    3.  Set the AF signal to 1 kHz.

  4.  Set the RF level to 1 mV pd (- 47.0 dBm )

  5.  Adjust T2 for maximum AF output about 250mVto 350mV and lowest distortion,

      the distortion normally less than 5﹪.

    6.  Check for an RF voltage signal level of 0.35uV pd (- 116dBm)and a SINAD meter

        Reading greater than 12 dB.

        

Squelch�C a r r i e r  D e t e c t  A d j u s t m e n t

    1.  Set the RF signal generator to the receiver frequency with 60﹪deviation. Set the AF

        Signal to 1 kHz

    2.  Set RF input level to give -112 dBm.

    3.  Adjust VR101 until CDS J1 pin 6 changes state from “HIGH” to “LOW”.

    4.  Reduce RF input level to –120dBm and check that CDS line goes HIGH . Switch

        off the RF generator and disconnect the test equipment.
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Modulation Deviation Adjustment

     

    1.  Connect a power meter, modulation meter and oscilloscope to radio.

    2.  The radio should be programmed to contain a channel with a frequency in the middle

        the band of interest with an RF power setting of 2 W.

    3.  Switch the data radio ON.

    4.  Inject a 106mVrms SINE wave signal at a frequency of 1000Hz into pin 1 of J1,

      Set the data radio to TX Observe the oscilloscope display to check that the 1000Hz tone

        is a sine wave by tuning VR201and set deviation is 3.5KHZ.

    5.  Using the AF signal generator, sweep from 100 Hz to 3 kHz and record the peak

deviation.

     Check the peak deviation for appropriate channel spacing as follows：

 12.5 kHz channel spacing<= 2.5 kHz dev

 20 kHz channel spacing<= 4 kHz dev

 25 kHz channel spacing<= 5 kHz dev

  

  6.  Switch to RX.
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 7. TROUBLESHOOTING

   The section includes voltage which should assist the engineer to isolate and repair the fault.

   Voltage measurements should be made using a high-impedance voltmeter and the values given

   are with respect to ground.

   Careful alignment, using suitable test equipment, and quality interface cables should

   ensure that the radio meet their specified performance.

                                                                         

Voltage Charts

   Measurement Condition: 465MHZ,13.8V supply, RX Carrier Present.

Transistors .

               RX                 TX  Ref.  No.
     B      C      E      B     C      E

Q1     4.31     4.98     4.99     4.31     4.98     4.99
Q2     8.1     2.33     8.1     7.8     5.5     7.8
Q4     0     2.33     0     0     5.5     0
Q6     4.91     0     4.93     4.9     0     4.92
Q7     0     8.1     0     4.93     0.02     0
Q9     5.64     8.1     4.99     5.63     7.8     4.96
Q10     4.16     8.1     3.76     4.15     7.8     3.75
Q11     5.62     8.1     4.92     5.62     7.8     4.92
Q14     8.1     0.2     8.1     7.08     7.63     7.8
Q15     7.56     8.1     6.84     0.62     7.8     0
Q101     0.74     3.93     0     0     0     0
Q102     0.57     6.67     0     0     0     0
Q103     5.21     0     0     0     11.9     0
Q104     0.68     5.13     0     0     0     0
Q201     0     0.34     0     0     0.72     0
Q202     0.34     0.31     0     0.73     0     0
Q203     0.31     0     0.3     0     7.36     7.62
Q204     0     0     0     0.75     7.35     0
Q205     0     0     0     0.7     7.36     0.25
Q206     0     12.36     0     0.56     6.28     0
Q207     0     13.6     0     0     13.6     0
Q301     4.87     4.92     4.2     4.87     4.92     4.2
Q302     1.63     3.99     0.92     1.63     3.99     0.92
Q304     0.74     2.77     0     0.74     2.77     0
Q305     2.32     4.93     1.69     2.32     4.93     1.69
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Integrated Circuits
                               RECEIVER
Pin   IC1   IC2   IC3   IC4   IC5   IC101  IC201      
1  2.35  13.6   0   5  0   5.59   0          
2  2.39  8.1   5   5   0   5.05   0          
3  1.63  8.1   0   0  5   5.28   0           
4  4.93  6.86   0   5  0   5.63   0          
5  0  0   0   5  0   4.43   0          
6  0  8.1   5    4.08   4.43   0       
7  4.92  8.1   4.96   0   4.43   0       
8  3.52  0   0   5   5.63   0        
9  0   0     2.15   
10  0   0     0.78   
11  0   0     1.59    
12  4.9   0     0.58    
13  0   0       5.21    
14  0   0     0    
15  3.76   0     0
16  0   0     1.71
17      5   
18      0    
19      5     
20      5    
21   0   
22   0     
23   5     
24   5     
25   5     
26   2.07   
27   2.59   
28   5   

                 Integrated Circuit Voltages (Receive)
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Integrated Circuits

                       TRANSMIT

PIN  IC1 IC2 IC3 IC4 IC5IC101IC201       

1  2.35  13.6  0  0.58   0   0  1.16         
2  2.39  8.1  5  0.58   0   0  0        
3  1.65  8.1  0  0   5   0  0        
4  4.93  6.86  0  0.34   0   0  0         
5  0  0  0  5   0   0  2.43          

6  0  8.1  0.34      4.08   0  5.03      
7  4.92  8.1  4.92      0   0  2.48      
8  3.52  0  0      5   0  1.17       
9  0  0     0    
10  0  0      0    
11  0  0      0    
12  4.91  0      0   
13  0  0      0   
14  0  0      0   
15  3.76  0      0
16  0  0       0
17  4.98    
18  4.95   
19  4.98    
20  0    
21  0   
22  0   
23  4.98    
24  4.98    
25  4.98    
26  2.07   
27  2.59   
28  5   

                Integrated Circuit Voltages (Transmit)
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6. PARTS LIST

52-7085UE2  

                                              Revision:

Bill Of Materials  

 Item  Quantity  Reference                 Part

_____________________________________________________________

    1      19    C1,C40,C47,C48,C49,C51,   470P

                 C52,C106,C201,C216,C217,

                 C218,C221,C225,C227,C235,

                 C244,C247,C250

    2      11    C2,C108,C317,C550,C551,   1U/Y5V 0805

                 C552,C553,C554,C555,C556,

                 C558

    3       5    C4,C127,C224,C232,C234    5P

    4      16    C5,C7,C8,C12,C44,C103,    102P

                 C107,C121,C126,C203,C207,

                 C236,C245,C307,C312,C322

    5       1    C9                        475P/0805

    6       1    C11                       105P 25V/1206

    7      16    C13,C19,C29,C36,C37,C41,  104P

                 C42,C46,C53,C67,C102,

                 C111,C112,C117,C251,C546

    8       1    C15                       0.33U/T

    9       2    C16,C17                   103P/X7R

   10       1    C18                       106P/1206

   11       1    C20                       473P/X7R 0805
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52-7085UE2  

                                              Revision:

Bill Of Materials  

 Item  Quantity  Reference                 Part

_____________________________________________________________

   12       1    C21                       103P

   13       7    C30,C31,C32,C115,C122,    100P

                 C308,C524

   14       1    C33                       47U/16V/EC/SMT

   15       1    C34                       100U/16V/EC/SMT

   16       1    C35                       4.7U/1206

   17       4    C43,C50,C120,C223         22P

   18       3    C45,C116,C523             47P

   19       1    C101                      1P

   20       2    C104,C252                 1U/1206

   21       1    C105                      104P/X7R

   22       1    C110                      223P/X7R

   23       2    C118,C241                 10U/1206

   24       3    C123,C214,C323            15P

   25       5    C124,C125,C212,C220,C311  2P

   26       2    C202,C242                 10U/T

   27       2    C204,C302                 18P
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   28       1    C205                      335P/1206

   29       1    C206                      6P

   30       4    C208,C213,C228,C314       3P

   31       2    C210,C233                 10P

   32       4    C211,C230,C305,C306       7P

   33       1    C222                      12P

   34       2    C243,C248                 104P/0805

   35       1    C246                      223P

   36       5    C300,C301,C309,C324,C325  220P

   37       1    C303                      9P

   38       2    C304,C321                 8P

   39       1    CF1                       CFU455E

   40       3    D1,D5,D103                RLZ5.6B

   41       4    D2,D3,D101,D202           RLS4148

   42       1    D4                        RLZ4.3B

   43       2    D6,D507                   RLZ3.0B

   44       1    D102                      1SS226
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   45       1    D201                      1SS314

   46       1    D203                      PTZ3.9A

   47       2    D205,D303                 HVU131

   48       1    D206                      RLZ5.1B

   49       2    D301,D304                 1SV229

   50       1    F101                      SAW FILTER

   51       1    IC1                       MB1504 SMT

   52       1    IC2                       UTC7808

   53       1    IC3                       PIC16C57C04 SMT

   54       1    IC4                       ELM7S32

   55       1    IC5                       93C46 SMT

   56       1    IC101                     MC3361 SMT

   57       1    IC201                     LM386D

   58       1    IC504                     TL064CD SMT

   59       1    J1                        CONNECTOR DB9 HM

   60       1    J101                      BNC

   61       1    L101                      12NH
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   62       1    L102                      56NH

   63       1    L103                      2.2UH/BEAD

   64       3    L201,L203,L303            27NH

   65       1    L202                      15NH

   66       3    L204,L212,L213            0.45*1.5*5T

   67       2    L205,L206                 6.8NH/0603

   68       1    L207                      14UH

   69       2    L208,L214                 0.45*1.5*6T

   70       1    L210                      0.65*1.1*4T

   71       1    L216                      125MH

   72       2    L300,L301                 1UH/BEAD

   73       1    L304                      18NH/SPRING COIL

   74       2    Q1,Q6                     A1037K

   75       2    Q2,Q14                    BCW68G

   76       8    Q4,Q9,Q10,Q11,Q15,Q201,   BC847B

                 Q202,Q301

   77       2    Q7,Q103                   DTC114EK
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   78       1    Q101                      2SC4226

   79       6    Q102,Q204,Q205,Q302,Q304, 2SC5226

                 Q305

   80       1    Q104                      MMBTH10

   81       1    Q203                      DTA123JK

   82       1    Q206                      BFR96TS

   83       1    Q207                      MRF555

   84       9    R1,R17,R50,R201,R205,     10K

                 R308,R518,R521,R524

   85       8    R3,R47,R118,R516,R523,    100K

                 R525,R528,R531

   86       1    R4                        0R

   87       2    R5,R11                    910R

   88       6    R8,R20,R30,R103,R221,     2K2

                 R318

   89       3    R9,R22,R224               820R

   90       7    R10,R19,R101,R215,R222,   100R

                 R315,R316

   91       1    R13                       3K
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   92       2    R14,R15                   6K8

   93       2    R16,R111                  33K

   94       3    R23,R225,R304             150R

   95       5    R24,R41,R45,R107,R307     4K7

   96       1    R29                       12K

   97       7    R40,R46,R51,R52,R202,     1K

                 R223,R317

   98       5    R48,R49,R117,R204,R216    470R

   99       2    R53,R102                  1M

  100       8    R60,R61,R526,R527,R532,   47K

                 R533,R534,R546

  101       1    R104                      220K

  102       3    R105,R208,R220            22K

  103       1    R106                      1.5M

  104       3    R108,R212,R311            2K7

  105       3    R110,R112,R113            560R

  106       2    R114,R314                 1K2
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  107       2    R115,R217                 470K

  108       3    R116,R211,R213            22R

  109       1    R203                      27K

  110       1    R206                      1.5K

  111       1    R207                      220R

  112       1    R210                      3K3

  113       1    R214                      22R/0805

  114       1    R301                      10R

  115       1    R302                      5K6

  116       1    R303                      3K9

  117       1    R306                      33R

  118       1    R309                      330R

  119       1    R312                      270K

  120       1    R313                      56R

  121       1    R517                      15K

  122       1    R545                      680R

  123       2    RV501,RV502               10KB SMT
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  124       1    T2                        0766

  125       1    VC1                       20PVC

  126       1    VR1                       100KB SMT

  127       1    VR101                     47KB/SMT

  128       1    VR201                     10KB/SMT

  129       1    X1                        12.8MHZ TCXO/SMT

  130       1    X2                        3.58MHZ 3X9

  131       1    X101                      20.945MHZ UM1

  132       1    XF1                       21M08B

  128      2   SCREW                 M2X4 F.E.G NI

  129      4   SCREW                 M2X3 BH NI

  130      4   SCREW                 M3X3 BH NI

 

  131      1   CABLE                 RG178-50

  132      1   SHIELD                VCO

  133      1   PRINT CIRCUIT BOARD   110x55x1.0 m/m FR4

  134      1   CASE                  TOP

  135      1   CASE                  BOTTOM
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     Welcome to PC Programmer.

     Please Read this file, before you first use the software.

TABLE OF CONTENTS

1.  Brief introduction

2.  Before Installing

3.  Install PC Programmer

4.  INSTRUCTIONS

5.  UnInstall PC Programmer

1.  Brief introduction

        Welcome to PC Programmer. This program is designed to be used with the

        Interface Adapter.

        The following equipment will be needed to program the Device:

     A. A computer to install this program with at least 2 MB available space

        in hard disk and a 9-pin male RS-232 serial port.

     B. Win 95,Win 98,Win ME or Win 2000 Operation System.

     C. Part of the Programming Kit

        1) An interface Adapter.

        2) A CD disk with the program, PC Programmer files

2.  Before Installing

        Before You Run Setup, make sure that your computer meets the minimum

        requirements mentioned above, and read the Readme file(this file).

    NOTE: If you firstly install PC Programmer in you system, the setup may

          update some system files on your computer , so you may run the

          setup again after your system be updated. Please follow the

          installation instruction on the screen.

3.  Install

     TO install PC Programmer on your computer

     1)Insert the CD.

     2)Run Setup.exe

     3)Follow the installation instruction on the screen.

     Important:  You cannot simply copy files from the CD to your hard disk

                 and run PC Programmer . You must use the Setup program,

                 which decompresses and installs the files in the appropriate

                 directories.                                           PAGE 29      



4. INSTRUCTIONS

  

    4.1 Connection

    4.2 Start up PC Programmer

    4.3 Edit Configuration

        4.3.1 Open/Recall/Upload Configuration file

        4.3.2 Edit Channel data

        4.3.3 Set Option item

        4.3.4 (Block)Cut/Copy/Delete/Paste

        4.3.5 Auto-Frequency edit

        4.3.6 Save a Configuration to disk

        4.3.7 Download Configuration to device

        4.3.8 Print a Configuration

    4.4 Exit PC Programmer

   

  

    4.1 Connection

        1.Connect one side of Interface Adapter to the computer's serial port.

          Never care the port number, the PC Programmer will locate it

          automatically.

        2.Connect the other side of Interface Adapter to the Device's 9-pin

          male RS-232 port.

        3.Connect power supply to device and LED will be light. The device will into

          PC_programming mode automatically, please see the picture of below.
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    4.2 Start up PC Programmer

        1.Select 'Start', choose 'Programs', click on the '*** Serial PC

          Programmer' program.

        2.When HD Serial PC Programmer is started, a main form will be shown

          after a greeting form.

3.There has a menu bar at the top of the main form, and a message  box

          at the bottom.
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NOTE:The program is menu driven for all pertinent commands. All the

             commands can be accessed by either key board or the left mouse

             button.

             Access keys mainly used are:

     'Tab' or 'Arrow'   to move focus(or cursor)

     'Enter' to active a focused command

    4.3 Edit Configuration

     

      4.3.1 Open/Upload Configuration file

    To edit the configuration, please either

          1)Recall an Existing Configuration by click on the 'Open' item in

            the File Menu, select the configuration file by click on or input

            its name then press 'Enter' key.

       OR 2)Upload configuration data from a device by click on 'Upload' item

            in the Device menu. to a Configuration window .

    Different Model's device Configuration can be opened and edited.

            There are two fields in each Configuration window: system data

            and Channel data.

       OR 3)Open an existing Configuration by click on the 'OPEN' item in the

            File Menu. A pop up window will be shown, select a file by arrow

            key or mouse then click 'OK'.

   

      4.3.2 Edit Channel data

  1)Set focus to the Channel data field by move the mouse pointer.

  2)Select a particular channel number to be edited by either the

            arrow key or click on it.

  3)Pop up input window by either press 'Enter' key or double click

            on the selected channel number.

  4)Use computer's cursor keys, Tab key, Enter key, arrow key or

            mouse to renew the channel data.

  5)Click 'OK' button on the input window to accept the change or

    'Cancel' to not change, and return back to Configuration Window.

      4.3.3 Edit Option item

  1)To Edit Channel Option, Select a particular channel number in

    the Option View Window by either the arrow key or click on it,

    then Pop up the input window for Channel Option, 'Enter' key or

    double click on the selected channel number.
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  2)To Edit System Option, Pop up input window for System Option,

    click "SYSTEM" in the 'OPTION' menu.

          3)To Edit Advanced Option, Pop up input window for Advanced Option,

            click "ADVANCED OPTION" in the 'OPTION' menu.

  4Use computer's cursor keys, Tab key, Enter key, arrow key or

            mouse to renew the Option Item.

  5)Click 'OK' button on the input window to accept the change or

      'CANCEL' to not change, and return back to Configuration Window.

       

      4.3.4 (Block)Cut/Copy/Delete/Paste

  To select a block of channel data as source by either

  1)Select start channel by arrow key, then while press 'Shift' key

            select end channel number by arrow key.

  2)Click on start channel, then while press 'Shift' key click on

            end channel number

      3)Press the left mouse button on start channel then move the mouse

    until reach the end channel number, release left mouse button.

  A)To Cut selected (block) Channel(s) either press 'Ctrl'+'X'or

    click 'CUT' item in Edit menu.

  B)To Copy selected (block) Channel(s) either press 'Ctrl'+'C'or

    click 'COPY' item in Edit menu.

  C)To Delete selected (block) Channel(s) either press 'Del(Delete)'

    key or click on 'DELETE' item in Edit menu.

    After Cut or Copy, the data can be pasted to where you want.

  D)To Paste , select a channel as the start number of target , then

    either  press 'Ctrl'+'V' or click on 'PASTE' item in Edit menu.

            NOTE: Paste operation allows you to export data to any Configuration

          window opened.

      4.3.5 Auto-Frequency edit

      This feature provide you with a quick Frequency set function.

          To use this command after either

  1)Click 'EDIT' Menu

  2)Click on 'AUTOFREQ' item in 'EDIT' menu to pop up a input window.

  3)Use computer's cursor keys, Tab key, Enter key, arrow key or mouse

            to set data.

  4)Click 'OK' button on the input window to accept the change or

    'CANCEL' to not change, and return back to Configuration Window.
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      4.3.6 Save a Configuration to disk

  1)Different configuration can be saved to disk.

  2)Click on 'SAVE' item in 'FILE' Menu will overwrite an existing

            configuration file on your disk by current configuration.

  3)Select 'SAVE AS' from 'FILE' Menu will save the current

            configuration by  a name as you prefer.

      4.3.7 Download to device

    To Download current Configuration to device, select 'DOWNLOAD' from

          sub menu under 'DEVICE' menu.

      4.3.8 Print a Configuration

    Click on 'PRINT' item in 'FILE' Menu will send current Configuration

          to printer.

    4.4 Exit PC Programmer

To Exit PC Programmer,click on 'EXIT' item in 'FILE' Menu.

5.  UnInstall PC Programmer

        To uninstall PC Programmer from your hard disk,  select 'Start'

    , choose 'Settings', click on the 'Control Panel', then find 'Add/Remove

    Programs' icon from the pop up window then double click on it, then find

    '*** Serial PC Programmer' from application list and click on it, then click

    on 'Add/Remove' button under application list, then follow the

    instructions on your screen.
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Federal Communication Commission Interference

Statement

This equipment has been tested and found to comply with the limits for a Class

B digital device, pursuant to Part 15 of the FCC Rules.  These limits are

designed to provide reasonable protection against harmful interference in a

residential installation.  This equipment generates, uses and can radiate radio

frequency energy and, if not installed and used in accordance with the

instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular

installation.  If this equipment does cause harmful interference to radio or

television reception, which can be determined by turning the equipment off and

on, the user is encouraged to try to correct the interference by one of the

following measures:

l                Reorient or relocate the receiving antenna.

l                Increase the separation between the equipment and receiver.

l                Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected.

l                Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the

party responsible for compliance could void the user's authority to operate this

equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the

following two conditions: (1) This device may not cause harmful interference,

and (2) this device must accept any interference received, including

interference that may cause undesired operation.

 

2.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two

conditions: (1) This device may not cause harmful interference, and (2) this device must

accept any interference received, including interference that may cause undesired operation.



FEDERAL COMMUNICATIONS COMMISSION
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:(1) this device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

NOTE
This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiated radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

-Reorient or relocate the receiving antenna.
-Increase the separation between the equipment and receiver.
-Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
-Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the party responsible for compliance
could void the user‘s authority to operate the equipment.

The antenna(s) used for this transmitter must not be co-located or operating in conjunction with
any other antenna or transmitter
  
 




